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Welcome to IUEditor Manual.

You can download IUEditor from website below.


	IUEditor Homepage : http://iueditor.org


	IUEditor Facebook Page (Korean): https://www.facebook.com/iueditor
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What is IUEditor?

IUEditor is optimized to simplify the complex process of design and development.


Advantages


	IUEditor is a GUI-based program which allows users to design a prototype without any coding.


	Also, IUEditor allows users to develop a product or a website that supports multi-screen devices with just one IU project file.


	IUEditor is integrated via backend layers such as python.







Values


	IUEditor enables designers to work together with developers without publishers so that your team or company can save cost and time.


	Furthermore, IUEditor enables your team or company to ship products early, so you can adopt a lean process and iterate to build a better product or website.







More …


	You can check javascript manual on http://cdn.iueditor.org/js/readme.html










          

      

      

    

  

    
      
          
            
  
Environment

IUEditor operates only on Mac OS X - Mojave. (10.14 +)

Browser support : Chrome, Safari, Firefox, Opera - current / IE 9+





          

      

      

    

  

    
      
          
            
  
Menu

[image: _images/iu_manual_basic_menu.png]

Description about IUEditor Menu Bar




IUEditor

[image: _images/iu_manual_basic_menu_iueditor.png]

	About IUEditor : Show IUEditor’s version info.


	Preference : Open IUeditor Preference window.









File

[image: _images/iu_manual_basic_menu_file.png]

	New Project : Open New Project window.


	Open : Open Finder to find IU Project file to open.


	Open Recent : Open recent IU Project file.


	Save : Save the current project.


	Duplicate : Duplicate the project’s current path.


	Rename : Edit the name of the project.


	Move To : Change current project’s path .


	Close : Close current project.









Project

[image: _images/iu_manual_basic_menu_project.png]

	Build : Generates HTML & CSS & JS files based on IU Project.


	Build Clean : Clean build data. It can fix program error.


	Project Setting : Opens Project Setting panel.


	Refresh Page : Refresh current page. It can fix program error.









View

[image: _images/iu_manual_basic_menu_view.png]

	ZoomOut : Zoom Out stage.


	ZoomIn : Zoom In stage.


	Outline : Show or hide outline of widgets in canvas.


	Widget Info : Show or hide information of widgets in canvas.


	Ruler : Show or hide ruler on canvas.


	Guide : Show or hide guide on canvas.


	Tracing : Show or hide tracing image on canvas.









Window

[image: _images/iu_manual_basic_menu_window.png]

	Event : Opens Event panel .


	Resource : Opens Resource panel .


	Memo : Opens Memo panel .


	Manage Custom Widgets : Opens Manage Custom Widgets Panel .









Help

[image: _images/iu_manual_basic_menu_help.png]

	Search : Search IUEditor function.


	Documentation : Open IUEditor Manual page in the brower.


	Visit IUEditor : Open IUEditor Homepage page in the brower.


	Visit Facebook : Open IUEditor Facebook page in the brower.










          

      

      

    

  

    
      
          
            
  
Top Toolbar

[image: _images/iu_manual_top_toolbar.png]
Top Toolbar contains Command / Tab Menu / Stage area.



[image: _images/iu_manual_top_toolbar_command.png]

Command

Command Area consists of project-level features.


	Build Button : Generates HTML & CSS & JS files based on IU Project.


	Server Stop Button : Stops the local host server.


	Select Build-Type Button : Select Build-Type to Build. (HTML or Django)


	Scenario / Edit Mode Toggle Button : Switches Edit Mode to Scenario Mode and vice versa.









Tab Menu

Tab Menu area consists of 6 tabs - Style/ Property/ Text/ Transform/ Mouse-Over/ and Link.

[image: _images/iu_manual_top_toolbar_tab03_style.png]

	Style Tab : In Style Tab, you can modify Radius / Border / Background-Image / Box-Shadow / Opacity.




[image: _images/iu_manual_top_toolbar_tab02_property.png]

	Property Tab : In Property Tab, you can set & change properties of each widget. Each widget has individual property options.




[image: _images/iu_manual_top_toolbar_tab01_text.png]

	Text Tab : In Text Tab, you can modify Font-family / Font-size / Font-weight (thinkness) / Font-color / Line-height / Heading / Font-alignment.




[image: _images/iu_manual_top_toolbar_tab04_transform.png]

	Transform Tab : In Transform Tab, you can modify Rotation property.




[image: _images/iu_manual_top_toolbar_tab05_mouse_over.png]

	Mouse-Over Tab : In Mouse-Over Tab, you can add Mouse-Over actions to each widget. (e.g. BG-color, Text-color, X-position, Y-position, width, height, BG-image position, …)




[image: _images/iu_manual_top_toolbar_tab06_backend.png]

	Link Tab : In Link Tab, you can add Hyperlink to a certain widget.






[image: _images/iu_manual_top_toolbar_TQZ.png]



Stage


	Fixed Widget Show / Hide Button : Switches show to hide Fixed Widgets.


	Tracing : Adds virtual background image into your canvas, so that you can create design quickly.


	Page Setting : Modifies current page’s Page Width and Media Query.


	Zoom : Applies Zoom-In / Out to IUEditor’s canvas.










          

      

      

    

  

    
      
          
            
  
Middle Toolbar

[image: _images/iu_manual_middle_toolbar.png]
Middle Toolbar is placed at the top of canvas and contains Page Capture / Position / Frame / Background-Color / Show/Hide Widget Button area.




Page Capture

Captures the current page and adds custom thumnail in Prototype Mode.






Position

Position area consists of Position/ Align options/ Input fields/ Stepper for X & Y position.


	Position : Select position from select - Absolute/ Relative/ Fixed.


	Sub Position : Select sub position from select.


	Allign Button : Consists of align vertical center and align horizontal center buttons and align multiple element button.


	Position Setting Popup (Down Arrow) : You can change fixed center position, overflow, z-index properties.


	X posiition input field & stepper : You can change X value by typing value into text field or clicking stepper. (px or %)


	Y posiition input field & stepper : You can change Y value by typing value into text field or clicking stepper. (px or %)









Frame

Frame area consists of Input fields/ stepper for width & height value.


	Width input field & stepper : You can change Width value by typing value into text field or clicking stepper. (px or %)


	Height input field & stepper : You can change Height value by typing value into text field or clicking stepper. (px or %)


	Frame Setting Popup (Down Arrow) : You can change min-width , max-width , min-height , max-height , calc-width , calc-height properties.









Background Color

Background Color area consists of set background color button/ set gradient popup. You can change the background color and the color gradient of the selected widget.






Show/Hide Widget Button

Show and Hide widget list.







          

      

      

    

  

    
      
          
            
  
Widget Panel

Widget toolbar is at the right side of canvas. Open and close Wiget Panel with Show/Hide Widget Button in the middle tool bar. Widget panel consists of IU Widget / Custom Widget tab.




IU Widget

[image: _images/iu_manual_iuwidgets.png]
In IU WIDGET tab, all available widgets in IUEditor will be shown. Fundamental elements including Box / Text / Image / Static Image / Cell widgets and other various widgets used in a web page are offered. All the provided widgets are divided into Base, Complex, Programming groups. You can see the detailed information of each widget by right-clicking the widget.

Go To Widget Property






Custom Widget

[image: _images/iu_manual_customwidgets.png]
In CUSTOM WIDGETS tab, custom widgets imported by Import Button (Window> Manage Custom Widgets) will be shown. The widgets can be divided into customized widget groups. You can add custom widgets on canvas by drag and drop or double clicking the widget. You can check the detailed information of a widget by right-clicking it. All the information of custom widgets can be edited at Manage Custom Widget window.


	Refresh Button : Updates custom widget library.


	Search Field : Search custom widget library by name or tag.


	Zoom in/Zoom out Button : Zoom in or out custom widget library.




Go To Manage Custom Widgets Panel







          

      

      

    

  

    
      
          
            
  
Navigation

[image: _images/iu_manual_navigation.png]
Navigation area is at the left side of canvas. Three key elements are Structure , Page ,and Composition.




Structure

The components of the current page (section, header, footer, page content, widget, …) can be seen in this area.

You can rearrange, remove, rename, and hide widgets from the structure.


	Add New Popup : Add a popup widget into the current page.


	Add New Panel : Add a panel widget into the current page.


	Add New Section : Add a section to the page content.


	Delete : Delete the selected element.









Page

Page tab shows the list of pages/groups included in the current project. You can add, remove, and rename pages/groups.


	Add New Custom Page Button : Adds a new custom page.


	Add New Page Button : Adds a new page.


	Add New Group Button : Adds a new group.


	Delete Button : Delete the selected page or group.









Composition

Composition tab shows the design compositions of the current project. You can add, remove, and rename composition & group.


	Add New Custom Composition Button : Adds a new custom composition.


	Add New Composition Button : Adds a new composition.


	Add New Group Button : Adds a new group.


	Delete Button : Delete the selected composition or group.









References

How to rename widget, page, and group


	Select the item (widget, page, or group) you want to rename


	Press Enter or Tab key


	Type new name as you want


	Press Enter Key





Note

You can not use these names : id / ifdef / default









          

      

      

    

  

    
      
          
            
  
Canvas

[image: _images/iu_manual_canvas.png]
Canvas is the preview of the website. The structure designed on the canvas by adding widgets  will be shown in the web page.

`How to add widgets to canvas`_




Context Menu - Single Widget

[image: _images/iu_manual_canvas_context_single.png]
After selecting a single widget in canvas, right-click to open the Context Menu.
Below are information and functions in the Context Menu.


	Widgets : Shows the whole widgets placed at the current position of the mouse pointer.




[image: _images/iu_manual_canvas_context_single_widget.png]

	Add Memo : Opens Memo Panel where you can add memo about the selected widget.


	Export to Widget : Opens Export Widget Panel that is used to export Custom Widget .


	Show Event : Opens Event Panel that allows us to add an event to the selected widget and later make adjustments on events


	Select Tab : Switches Property panel on the top to the selected `Tab`_









Context Menu - Muiltiple Widgets

[image: _images/iu_manual_canvas_context_multi.png]
After selecting multiple widgets in canvas, right-click to open the Context Menu.


	Align : Aligns the selected widgets according to the option chosen : Align Left / Align Center / Align Right / Align Top / Align Middle / Align Bottom




[image: _images/iu_manual_canvas_context_multi_align.png]

	Size : Fixes the size of the selected widgets according to the option chosen : Match Width / Match Height




[image: _images/iu_manual_canvas_context_multi_size.png]






          

      

      

    

  

    
      
          
            
  
Developer Mode

[image: _images/iu_manual_developer_mode.png]
From the toolbar at the top, you can switch to Developer Mode by clicking Mode Switching Button.

In Developer mode, Code Panel will be shown. It consists of HTML ID / Custom Code .




HTML ID

You can check and change HTML ID here. There is a check box for Export HTML ID. At the Project panel (IUEditor Menu Bar > Preference), you can set the options from Export HTML ID Option. (Offered options: Always include/ Optimization & customization)






Custom Code

You can write back-end, custom css, script code. The tab composition differs between widget and project type.







          

      

      

    

  

    
      
          
            
  
Prototype Mode

[image: _images/iu_manual_advanced_prototype_mode.png]
From the toolbar at the top, you can switch to Prototype Mode by clicking Mode Switch Button.

Prototype Mode offers Revision History / Project Workflow / Node Description page.
You can refresh scenario by clicking Reset Workflow and can build HTML Scenario by clicking Build Senario.
And Refresh Thumbnail updates the page thumbnails that are included in the workflow and the page list.




Revision History

[image: _images/ic_SB_revision.png]
Displays the history of revision made in the current project. You can add or change the history.


	Add New Date : Creates a new editable row field in the table.


	``Remove Date `` : Deletes the selected row from table.









Project Workflow

[image: _images/ic_SB_workflow.png]
Displays Workflow of the current project. Users can add nodes by drag and drop of page thumbnails. Press delete key to delete the selected node.

[image: _images/iu_manual_advanced_prototype_mode_thumbnail.png]

	Default thumbnails : A list of page thumbnails included in the project.


	Custom thumbnails : A list of page thumbnails captured by using Page Capture Button on the toolbar in editor mode.





Note

Thumbnails can be added by using Page Capture Button  in Editor Mode.



[image: _images/iu_manual_advanced_prototype_mode_workflow.png]

	Rectangle Button : Adds a square dialog below the selected node.


	Rhombus Button : Adds a diamond dialog below the selected node.


	Inward Label : Adds a label on top of the selected node.


	Outward Label : Adda a label below the selected node.









Node Description

[image: _images/ic_SB_screen.png]
Displays the Node Description of the selected page. By adding memos to the node, you can send orders to partners of your collaborative project. You can also add or change content in the Screen Description or Exception area. Double-clicking the thumbnails on canvas also displays the node description.


	Memo image area : Selects an image from the resource panel to replace the numbering in the screenshot area.


	Add Memo Button : Creates a new editable row field in the table.


	Delete Button : Deletes the selected memo in the table.




When you click the screenshot area, the number of the selected memo will apear.







          

      

      

    

  

    
      
          
            
  
Project Setting

When you run Project > Project Setting (⇧⌘P) menu, Project Setting will be shown. You can modify settings from Default , Meta , Build , Django Tab menu.



[image: _images/iu_manual_project_setting_01default.png]

Default


	Project Title : Adds the title of the project.


	Favicon : Adds favicon image (Favicon image resource is required).


	Custom Header Code : Adds custom code which will be applied to each page of the current project.





Note

After creation of a new project, Project Default Width cannot be changed.





[image: _images/iu_manual_project_setting_02meta.png]



Meta


	Meta Image : Adds Meta Image for meta-data. (URL)


	Author : Adds Author name for meta-data.


	Project URL : Adds Project URL for meta-data.


	Project Keywords : Adds Project Keywords for meta-data. (Multiple keywords are available)


	Project Description : Adds Project Description for meta-data.


	Facebook Admin : Adds Facebook Admin ID for meta-data.


	Facebook App ID : Adds Facebook App ID for meta-data.






[image: _images/iu_manual_project_setting_03build.png]



Build


	Build Path : Set Build path for built files.


	Build Resource Path : Set Build Resource Path for built resource files.


	Resource Prefix : Set Resource Prefix.


	Link Prefix : Set Link Prefix.


	HTML Port : Set HTML Port for build.





Note

If your project’s domain isn’t the same as the root path, you have to modify Resource & Link Prefix.





[image: _images/iu_manual_project_setting_04django.png]



Django


Note

Django tab is available on Django Project .




	Django Build Path : Set Django Build path for Django build files.


	Django Resource Path : Set Django Resource Path for Django resource files.


	Django Resource Prefix : Set Django Resource Prefix.


	Runserver after build : Set Runserver option.


	Django Port : Set Django Port for Django build.


	Python Interpreter Path : Set Python Interpreter Path for Django build.


	Django Manage.py Path : Set Manage.py path for Django build.










          

      

      

    

  

    
      
          
            
  
Resource Panel

When you run Window > Resource (⇧⌘R) menu, Resource Panel will be shown. You can import resources (image / video / clipart) into Resource Panel.


Note

Supported File Type : jpg / png / git / svg / mp4



[image: _images/iu_manual_panel_resource.png]

	Import Resource Button : Imports resources from the local disk.


	Import Clipart Button : Imports cliparts from Import Clipart .


	Resource Type Select Button : Sorts out files in Resource Panel by file type.


	Add New Folder Button : Adds a new folder.


	Delete Button : Deletes the selected file(s) or folder(s).







Import Clipart

You can import clipart images that are supported by IUEditor.

[image: _images/iu_manual_panel_resource_clipart.png]

	Import : Imports selected clipart(s)


	Cancel : Closes Clipart Panel.


	Grid / List View Change Button : Switches view type (List & Grid).


	Clipart Type Select Button : Sorts out clipart in Clipart Panel by tag.


	Search : Searches by filename.









Resource Management Tips


	You can create groups and reorder files in resources.


	You can insert image resources to widget by drag & drop into Image Widget .










          

      

      

    

  

    
      
          
            
  
Event Panel

When you run Window > Event (⇧⌘E) menu, Event Panel will be shown. You can add events like Scroll Animator or Variable .



[image: _images/iu_manual_panel_event_01scr.png]

Scroll Animator

Adds Scroll Animator to animate widget by scrolling. When target widget closing to middle of browser, selected value will transform from before to after.


	X-Position : Adds Scroll Animator to X-Position.


	Y-Position : Adds Scroll Animator to Y-Position.


	Opacity : Adds Scroll Animator to Opacity.






[image: _images/iu_manual_panel_event_02var.png]



Variable

Adds Variable to the selected widget.


	Variable Name : Shows Variable list in your project.


	Triggered Widget : Shows Triggered widget list according to the selected variable.


	New Variable Name : Adds a new variable name.


	Value Count : Set Default & Maximum value to the variable.


	Trigger Action : Set Trigger Action to the selected widget.






[image: _images/iu_manual_panel_event_03receiver.png]



Receiver

Adds Receiver Event to the selected widget. When Equation returns True, Receiver Event will be shown.


	Variable Name : Shows the list of variables that have Receiver Event.


	Receiver Widget : Shows the list of Receiver Widget according to the selected variable.


	Equation : Set Equation case. (e.g. Sample Variable = 1)


	Scroll Location : Set Equation range of the scroll position.


	Animation Effect : Set Animation Effect when Receiver Event is run.


	Duration : Set Duration for the Receiver Event.










          

      

      

    

  

    
      
          
            
  
Memo Panel

When you run Window > Memo (⇧⌘M) menu, Memo Panel will be shown. You can add a memo to the selected widget.

[image: _images/iu_manual_panel_memo.png]

	Show / Hide Table Toggle Button : Open or Close Memo List area.


	Title : Adds title to the selected memo.


	Memo : Adds memo to the selected widget.





Note

In the Memo List, you can modify Memo’s Number / Title / Content .







          

      

      

    

  

    
      
          
            
  
Manage Custom Widget Panel

When you run Window > Manage Custom Widgets (⇧⌘W) menu, Manage Custom Widgets Panel will be shown. You can import Custom Widgets, Compositions and Pages into this panel. This panel supports Grid / Table view in Widget list. You can open and close widget information area with toggle button next to the search box.

[image: _images/iu_manual_panel_import_widget.png]



Top Bar


	Widget Tab : Manage imported custom widgets. Import custom widget with import button.


	Page Tab : Manage imported custom page. Import custom page with import button.


	Composition Tab : Manage imported custom composition. Import custom composition with import button.


	Widget Information Toggle Button : Show or hide `Custom Widget Information`_ area.


	Search Bar : Searches by custom widget name.









Widget Group List

Widget Group List is placed at the left side of the panel. You can browse Custom Widget List by selecting the group name.






Custom Widget List

Custom Widget List is placed at the center of the panel.


	Import : Imports custom widget file. (iuw)


	Refresh : Refreshes current widget list.


	Open Folder : Opens custom widget folder.









Custom Widget Info

Custom Widget Info is placed at the right side of the panel.


	Preview : Shows the preview of the selected custom widget.


	Zoom In / Out : Zoom In or Out on the preview.


	Name : Displays the name of the selected custom widget.


	Group : Displays the group of the selected custom widget.


	Tag : Displays the list of tags added to custom widgets.


	Description : Displays the description of the selected custom widget.










          

      

      

    

  

    
      
          
            
  
Export Widget Panel

You can open Export Widget Panel from the left side of the canvas:


	Right-click the widget in structure section


	Right-click the page in pages


	Right-click composition in compositions




[image: _images/iu_manual_panel_export_widget.png]

	Customize Viewport Size : Resizes viewport size of the custom widget.


	Name : Sets name of custom widget.


	New Group : Sets the group of the custom widget.


	Export Directory : Sets the export directory of the custom widget.


	Description : Adds descriptions to the cutsom widget.







Export Widget (.iuw)

[image: _images/icon_IUW_128x128.png]
When you export Widget , IUEditor generates CustomWidgetName.iuw file.






Export Page (.iup)

[image: _images/icon_IUP_128x128.png]
When you export Page , IUEditor generates CustomPageName.iup file.






Export Composition (.iuc)

[image: _images/icon_IUC_128x128.png]
When you export Composition , IUEditor generates CustomCompositionName.iuc file.







          

      

      

    

  

    
      
          
            
  
Project Type

[image: _images/icon_IU_128x128.png]



Default Project

Default Project is a Static Project which is not connected with any back-end framework. You can select Default Project in New Project Popup (which pops up when you run File > New Project (⌘N) menu)

[image: _images/iu_manual_project_new_default.png]

	Empty Page (Header / Footer) : Creates new project with Empty Page (Header / Page Content / Footer)


	Empty Page (Header) : Creates new project with Empty Page (Header / Footer)


	Empty Page (Blank) : Creates new project  with Empty Page (Page Content)


	IUPro : Creates new project with IUPro Template.


	Paper : Creates new project with IUPaper Template.


	IUAcademy : Creates new project with IUAcademy Template.


	Recent Project : Shows last 5 projects that recently have been updated.


	Open Project : Opens existing IU project.





Note

When you select Empty Page, you can set default width value of new project.








Django Project

Django Project is a Dynamic Project which can be connected with Django as back-end framework. You can select Django Project in New Project Popup (which pops up when you run File > New Project (⌘N) menu)

[image: _images/iu_manual_project_new_django.png]





AngularJS Project

AngularJS Project is a Dynamic Project which can be connected with AngularJS as back-end framework. You can select AngularJS Project in New Project Popup (which pops up when you run File > New Project (⌘N) menu)

[image: _images/iu_manual_project_new_angularjs.png]






          

      

      

    

  

    
      
          
            
  
Page

[image: _images/IUPage.png]



Page Setting

When you click the Page Setting button, Page Setting panel will be shown.

[image: _images/iu_manual_sheet_page_setting.png]

	Empty Layout : Set Empty (Page Content) Page Layout .


	Header + Footer : Set Header + Page Content + Footer Page Layout .


	Header : Set Header + Page Content Page Layout


	Footer : Set Footer + Page Content Page Layout


	페이지 타이틀 Page Title : Adds Page Title to current page.


	페이지 키워드 Page Keyword : Adds Page Keywords to current page. (Multiple keywords available)


	페이지 설명 Page Description : Adds Page Description to current page.


	페이지 메타 이미지 Page Meta Image : Adds Meta Image to current page. (URL)









Page Custom Code

When you click the Page Custom Code button, Page Custom Code panel will be shown.

[image: _images/iu_manual_sheet_page_custom_code.png]

	Page Header Custom Code : Adds Custom Code in header of current page.


	Page Header Custom Code for Backend : Adds Custom Code for Backend in header of current page.









Page Default Widget

[image: _images/IUPage.png]
Page

[image: _images/iu_manual_prop_basic_IUPage.png]
IUPage is same as html document. You can change page structure in property tab.

[image: _images/IUHeader.png]
Header

[image: _images/iu_manual_prop_basic_IUHeader.png]
Header is placed top of page. Header can import Header or another composition .

[image: _images/IUPageContent.png]
Page Content

Page Content is placed middle of page (Page Content cannot be removed). You can add sections in Page Content.

[image: _images/IUFooter.png]
Footer

[image: _images/iu_manual_prop_basic_IUFooter.png]
Footer is placed bottom of page. Footer can import Footer of another composition .

[image: _images/IUSection.png]
Section

Section is placed under Page Content.

[image: _images/IUCenterBox.png]
Centered Box

Centered Box is placed under Section (Centered Box can be removed). Centered Box used for horizontal-center layout.

[image: _images/IUPanel.png]
Panel

[image: _images/iu_manual_prop_basic_IUPanel.png]
You can add a panel by press [+] button of panel group. To call panel, create link with any widget and select link target to panel.

[image: _images/IUPopUp.png]
Popup

[image: _images/iu_manual_prop_basic_IUPopup.png]
You can add a popup by press [+] button of popup group. To call popup, create link with any widget and select link target to popup.







          

      

      

    

  

    
      
          
            
  
Composition

[image: _images/IUClass.png]
You can create repeatable elements by using Compositions. Compositions will be imported to Import / Header / Footer / Collection widgets.





          

      

      

    

  

    
      
          
            
  
Basic Widget
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Box

[image: _images/iu_manual_prop_basic_IUBox.png]
Box widget is a fundamental widget which is generated to <div> tag. Mostly, Box widget is used to set layout and to group children widgets.
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Complex Widget
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Transition

[image: _images/iu_manual_prop_complex_IUTransition.png]
Transition widget has two transition items. When mouse action triggered, transition item will change from item 1 to item 2. You can set Mouse Action (Mouse Over or Click) , Transition Effect, and Duration in property panel.
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Carousel
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Carousel widget has multiple carousel items. You can simply make carousel interface with carousel widget. Carousel item is the same as Box widget, so you can add or remove child elements to Carousel item
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Google Map
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Google Map widget represents google map element. You can input Map location wherever you want.


	In Editor Mode, Google Map widget offers maximum preview 600 px x 600 px size.


	South Korea’s map is not available Color Theme feature.
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WebMovie
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Web Movie widget supports Youtube or Vimeo. You can use Web Movie widget with Short-Links :


	Vimeo : http://vimeo.com/ videoURL


	Youtube : http://youtu.be/ videoURL
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Video Clip

[image: _images/iu_manual_prop_complex_IUMovie.png]
Video Clip widget supports MP4. You can input videos from Resource panel.
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Table
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Table widget can add simple table on canvas.
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Simple Tab View
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Simple Tab View widget has more simple structure than Tab View widget .
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Tab View
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Tab View widget has multiple Tabs .
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Collapsible
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Collapsible widget has two item (Header and Content). When you triggered mouse action on Collapsible widget, Content item will be appeared. You can set Mouse Action (Mouse Over or Click) , Transition Effect, and Duration in property panel.
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Import
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Import widget can import Composition . If you want to use Composition, connect target Composition into Import widget.
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Tweet Share Button
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With Tweet Share Button widget, you can add Share to Tweeter Button in your project. (No Resize)

Property


	Child : Invalid


	Link  : Valid


	Scroll Animator : Valid


	Background Image : Valid


	Backend Ellipsis : Invalid






[image: _images/IUFBLike.png]



Facebook Like Button
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With Facebook Like Button widget, you can add Share to Facebook Button in your project. (No Resize)
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Centered Box
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Centered Box widget makes horizontal centered layout to Section. Centered Box widget is added into section automatically, but you can remove this widget. (No resize)
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Progress Bar
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Progress Bar widget displays a progress bar. If you want draw certain status with bar elements, add this widget in your project.

Property


	Child : Invalid


	Link  : Valid


	Scroll Animator : Valid


	Background Image : Invalid


	Backend Ellipsis : Invalid






[image: _images/IUSVG.png]



SVG (Scalable Vector Graphics)
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SVG widget displays Scalable Vector Graphics. You can select simple SVG form, or input custom svg code whatever you want.
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Programming Widget
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Form

[image: _images/iu_manual_prop_pg_PGForm.png]
Form widget is a container for programming widgets which is generated to <form> tag. If you want to use programming widgets, you must to add Form widget in your project.
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Input Text
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Input Text widget is a textfield which is generated to <input> tag (type : text).
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Input Paragraph Text
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Input Paragrapth Text widget is a textfield which is generated to <textarea> tag.
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Select
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Select widget is a select button which is generated to <select> tag. If you want to make select button, add this widget into Form widget.
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HTML (Hyper Text Markup Language)
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HTML widget is a code container which is generated to custom html tag (e.g. <style>, <script>, etc, …). You can make custom widget by input custom html code into HTML widget.
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Collection
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Collection widget can import multiple Composition widgets. If you want to make collection view with compositions, you can create collection view with Collection widget.

Property


	Child : Invalid


	Link  : Valid


	Scroll Animator : Valid


	Background Image : Valid


	Backend Ellipsis : Invalid






[image: _images/PGPageLinkSet.png]



Page Link Set
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Page Link Set widget displays page links that usually placed bottom of Collection.

주로 게시판이나 페이지 세트의 링크를 만들 때 사용합니다. 한 번의 몇개의 숫자를 나타낼 것인지 정할 수 있습니다.
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Checkbox
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Checkbox widget displays checkbox which is generated to <input> tag (type:checkbox).
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Radio Button
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Radio Button widget displays radio button which is generated to <input> tag (type:radio).
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Button
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Button widget displays button which is generated to <input> tag (type:default / reset / submit).
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File Upload
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File Upload widget displays file upload interface which is generated <input> tag (type:file).
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Switch
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Switch widget displays toggle button which is generated to <input> tag (type:checkbox), and contains two switch items.
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Flip Switch
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Flip Switch widget displays sliding switch which is generated to <input> tag (type:checkbox).
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Slide

[image: _images/iu_manual_prop_pg_PGSlide.png]
Slide widget displays slider interface. You can change value by dragging slide pointer. (Or type a number to value)
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Range Slide
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Range Slide widget displays range slider interface. You can change range vaule by dragging slide pointers. (Or type a number to value)
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Known Bug List

Here are bug list for current version.




Scroll Animator (Event Panel)

Scroll Animator is only available for Absolute Position widgets , Sometimes available for Relative Position widgets.






Unsupported variable name (Event Panel)

Variable name cannot have special characters and numbers, but only can Underbar(_).






‘#’ or ‘@’ character in File Path

If file path has ‘#’ or ‘@’ character, IUEditor cannot load resource path. Do not use ‘#’ or ‘@’ character in file path.
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Preference

Set IUEditor’s service environment.




General

[image: _images/iu_manual_preference_general.png]

	Select Tab Menu : Show or hide tab menus from top toolbar.


	Guide Line Color : Change guide line color. (View guideline : View > Guide ⌘;)


	Custom Template List URL : Input plist URL for apply custom template at new project window’s template list.









Project

[image: _images/iu_manual_preference_project.png]

	Project Save Option : Compress project’s json file if ‘Minimize Data’ checkbox checked.


	Compile Option



	Export HTML ID Option : Select whether contain HTML ID as default to all widget or customize.


	Name on Structure : Select whether contain widget’s name in html document or not.









	Resource Copy Option : Select how to do about multiple resources when ``Custom Widget``_ added on canvas.


	Widget Option : Select to contain centerbox in section as default .









Fonts

Add new webfont into font list.

[image: _images/iu_manual_preference_fonts.png]
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Templates

IUEditor offers free templates projects below. You can select template project in New Project panel.




	IUPro [http://iupro.iueditor.org]
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	IUPaper [http://iupaper.iueditor.org]
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	IUAcademy [http://iuacademy.iueditor.org]
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Shortcut




Project Management


	Project Setting (Shift+Cmd+P) : Opens Project Setting panel.


	Refresh (Shift+Cmd+F) : Refreshes current page.


	Import Custom Widget (Shift+Cmd+W) : Opens Custom Widget Panel.









Mode Switch


	Editor Mode (Cmd+[) : Switch to Editor Mode.


	Developer Mode (Cmd+]) : Switch to Developer Mode.


	Prototype Mode (Cmd+\) : Switch to Prototype Mode.









Add Widget


	IUBox (Cmd+1) : Select IUBox widget to add on canvas.


	IUText (Cmd+2) : Select IUText widget to add on canvas.


	IUImage (Cmd+3) : Select IUImage widget to add on canvas.


	IUStatic Image (Cmd+4) : Select IUStatic Image widget to add on canvas.


	IUCell (Cmd+5) : Select IUCell widget to add on canvas.









Widget Control


	Copy (Cmd+C) : Copy selected widget.


	Paste (Cmd+V) : Paste copied widget.


	Undo (Cmd+Z) : Undo steps.


	Duplicate (Cmd+D) : Duplicate selected widget.


	Redo (Shift+Cmd+Z) : Redo steps.









View Management


	Zoom In (Cmd+ +) : Zoom In stage.


	Zoom Out (Cmd+ -) : Zoom Out stage.


	Widget Panel (Cmd+Return) : Show and Hide Widget panel.


	Event Panel (Shift+Cmd+E) : Opens Event panel.


	Resource Panel (Shift+Cmd+R) : Opens Resource panel.


	Memo (Shift+Cmd+M) : Opens Memo panel.









Canvas View Management


	Show Outline (Cmd+L) : Show or hide outline of widgets in canvas.


	Show Widget Info (Cmd+I) : Show or hide information of widgets in canvas.


	Show Ruler (Cmd+R) : Show or hide ruler on canvas.


	Show Guide (Cmd+;) : Show or hide guide on canvas.


	Tracing (Shift+Cmd+T) : Show or hide tracing image on canvas.
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Dictionary

Definitions of words which used in this documents.




Build

Generates HTML & CSS & JS files based on IU Project.






Django

Python web framework.






Python

Server-side programming language.






Widget

Basic elements to create IU Project.
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Tutorials

Here are basic tutorials for IUEditor.

Go Tutorial [http://tutorial.iueditor.org/en/]




	Tutorial 101 - Blog-Style Web page [http://tutorial.iueditor.org/en/tuto01_blog.html]


	Tutorial 201 - Responsive Magazine View Part1 - Design [http://tutorial.iueditor.org/en/tuto02-magazine(en).html]


	Tutorial 202 - Responsive Magazine View Part2 - Media Query [http://tutorial.iueditor.org/en/tuto02-magazine-part2(en).html]
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IUEditor Manual

Welcome to IUEditor Manual Page.

You can download program from iueditor.org [http://iueditor.org].
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Scenario Mode

[image: _images/iu_manual_advanced_scenario_mode.png]
From the toolbar at the top, you can switch from Edit Mode to Scenario Mode by clicking Scenario / Edit Mode Switch Button.

Scenario Mode offers Revision History / Project Workflow / Screen Definition page. You can refresh scenario by clicking Refresh Scenario Button and can build HTML Scenario by clicking Document Build Button .




Revision History

[image: _images/ic_SB_revision.png]
Displays Revision History about the current project. You can add or change the history.






Project Workflow

[image: _images/ic_SB_workflow.png]
Displays Workflow (Page Links) about the current project.






Screen Definition

[image: _images/ic_SB_screen.png]
Displays Screen Definition about the selected page. You can add or change content in screen description or exception area.
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Upload to Server

[image: resource/iu_manual_advanced_server.png]
When you run  Project > Upload to Server(⇧⌘U) menu, Upload to Server Panel will be shown.

With this panel, you can upload the Built Files to your Server.
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Cutsom Code Panel

When you run View > Custom Code (⇧⌘C) menu, Custom Code Panel will be shown. You can write and save code.


Note

Custom Code Panel contains JavaScript (onClick / onChange / onLoad), HTML (inner code), SVG code.
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커스텀 템플릿 Custom Template

새프로젝트 만들기에 노출되는 템플릿 목록을 커스터마이즈 할 수 있습니다.
커스텀 템플릿을 적용하기 위해서 아래 